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« Download igﬁﬂﬂﬂ

http://www.dnr.state.mn.us/mis/gis/tools/arcview/extensions/
DNRGarmin/DNRGarmin.html
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"Mlnncsou | search |
6« : - Depal‘tment of Natural Resources events | a-zlist | newsroom | about DNR | contact us
[ m f] rJ u | ’i @ m D N R G arl I l I n 5 4 1 Recreation Destinations Nature Education / safety Licenses / permits / regs.
L] L]

Home > About the DNR > Bureaus > Management Resources > MIS » GIS » ArcView Resources >

b DNR Garmin Application

Human Resources

Management &
Budget Services

A new version of DNRGarmin (DNRGPS)

azlA W4 dnrgarmin54setup.zir

Managemaent
Information Services Is now ava"ab'e
(M) Go to DNRGPS page

Current DNRGarmin Version:
ArcView Extension: 5.4.0
VB Program: 5.4.1
ArcGIS Toolbar: 5.4.0
Bulld Date: 9/2
Posted Date: 9/23/
Works With:
Arcview 3.x

a3, T E)

Bllbuide & 44

wandn  uenll  veaau A dathe  doymdren  Tdaaunu Aefue SF)« Aremap 9.x
Google Earth
= Landview
m Q drrgarmnS4setup.2ip - 1onans ZIP, wuwade 12,439,971 Tuvd v "
or DNRGarmin ¢an be acc elp menu
’ Y h et .
i & rTaTy gnifiu  wio gnuite mioad Program
" PN Folder DNRGarmin 5.4.1 (11.5 MB)
+ Last modified 9/22/08
:drvgarmrsel\pﬁd,ere 8,908,595 8,385,940 Appication 23j9j285] 8:29 * Known compatibility with NT/2000/XP
* 3 . ol = = + Compatible with ArcGIS 9.x (not 8.x), Arcview 3.x, ArcExplorer 2.0 (non
:mstms\a axe 1,708,856 1,668,914 Appication 28f11§2547 9:53 Java), Landview 4.3, Google Earth :(ou: Compatible with Colorado,
Hinstmein.exe 1,822,520 1,784,244 Appication 28112547 9:53 Oregon, and th i,

“*“‘The current version of DNRGarmin is not compatible with ArcGIS 10.
The toclbar will show up in ArcMap 10 and it will launch the ONRGarmin
application but DNRGarmin does not recognize that ArcMap is open. The
work around for the time being is to use File->Save To->File and File->Load
From->File.

= DNRGarmin 5.3.2 (11.5 M8)
+ Last modified 2/13/08
+ Known compatibility with NT/2000/XP
+ Compatible with ArcGIS 9.x (not 8.x), Areview 3.x, ArcExplorer 2.0 (non
Java), Landview 4.3, Google Earth. Note: USE CONNECTIVITY NOW WORKS.

= DNRGarmin 3.1.1 (10 M8)
+ Last modified 10/6/05
« Known compatibility with NT/2000/XP
+ Compatible with ArcGIS 8.x (not 9.x)

View the DNR No-Cost Software Distribution License Agreement

fppt.com
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 auanan dnrgarminsetup54.exe i

* AN Next tWaLTNNITEA RIS

ANINIIRARIIUTLNTH

DNRGarmin

Welcome to the InstallShield Wizard for

The [nst alShedd(R) Wizard vl install DNRGarrin on your
compater. To continue, chok Next,

WARNING: This program is protected by copyright law and
nternational tresties
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I
o A

e gausuRanlanilgIULaziaan Next iaa miunNsse

1% DNRGarmin - InstaltShield ¥Wizard

License Agreement "
Please read the folovang bcense agreament carelully. -

1) The Minnesota Departmwent of Natural Resources (MNDNR) A
grants to you a non-exclusive, non-sublicensable,
license to use this verzion of the DNR Garwin Extension.

Z) The MNDNR makez2 no representations2 about the
suitability of thiz Softvare or about any content or
information made accessible by the Software, for any
purpose, The Joftware i provided 'as is' without
express or implied wvarranties, including warrancies or
marchantabllity and fitness for a particular purpose or

——— o ————— - Tt Dot evrmumm S mmamment ool eyt e ) ..

T et the beras n the kcerse agreemert>
()1 do net accept the terms in the kenss agreement

< Bax Next > Cancel |
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o Tdsunsuaz@nsian C:\Program Files\dnrgarmin\ \aan Next

|§ DNRGarmin - InstallShield Wizard

Destination Folder :
Chek Naxt to install o this foldar, or chek Change o install ko & diferent Foldar, :
Iretall DNRGarmn to!
_‘ C:\Program Filesidnegarmin [ Change...

fppt.com
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= ——— < ng a
e AN FINnish 1 d7941N178 A RIS

1§ DNRGarmin - InstaliShield Wizard

InstallShield Wizard Completed

The InstaliShield Wizard has successfully nstalled ONRGarmn
It is strongly recommeanded that you restart your computer
before using DNRGarmin.  Clck Finish to exdt the wizard.

[T] show the readme file
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e N3N lgeulysnnsuy
o ng a ~ =
— sullanan Nierals AL

DME Garmin

— 438 Start --> All Programs --> DNR Garmin
B MN DNR - Garmin o @ |3

File Edit GPS Waypoint Track Route Real Time Help

Lat Lon

) . EPE »»» Data Table » =
:

fppt.com
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e FIANNNTITANFA
- 119 GPS --> Set Port --> USB
r B MN DNR - Garmin o @ |3

File Edit Waypoint Track Route Real Time Help

Set Port r

Lat Set Baud Rate b Port 1
i Part 2 aTable »5»

MHat Connects Open Port ort 2

Auto Connect to GPS Port 3

Close Port Ctrl+5 Port 4

Recet Garmin Port5

Port b

Garmin Screen Shot s

Garmin Info .

fppt.com
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e FIANNIITANAS

- WellsunsnmansanuiAresiudtyunce GPS wan

aztlsngTegu Asgl

Bl MN DNR - Garmin
File Edit GPS Waypoint Track Route Real Time

—
{__GPSMAP B2sc SEA 200 O

Lat Lon
EPE
Connected Frojection:
= _ D

=)

*»> Data Table >33

fppt.com
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¢ FNANTEZULNNA

- 1% File --> Set Projection

B MN DNR - Garmin o] B |23
Edit GPS Waypoint Track Route Real Time Help

Load From »

Save To »

»»r Data Table =

_(Set Projection >

Get Projection

General Properties

ArcMap 9.x Properties

Refresh Apps
Set App Refresh Rate

Exit

fppt.com
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Exd . o
¢ FNANTITUUNNA o amnpomie | ol
Projection T Wisypoint T Track T

- 119 File --> Set Projection R

Use ArcMap 9.x projection capabilities using
the PRJ definition specified below. Hote:

- La @ ﬂ ArC M ap Lﬁ @1{;‘ @ r] 3\] q j\ﬂ ArcMap 9.% needs to be installed with a licenze

available but doez NOT need to be running.

LapaAnng luldsunsn Arc Map &

See the ArcMap Tab for more ArcMap related
options.

- AaNtlu Load PRJ Wataaning

q

>
D
3¢

AT

PRJ Definition: Load PRJ |

PROJCS["WES_1984_UTM_Zone_47N' GEREEE——2
["GCS_WES_1984" DATUM
["D_WwWiGS5_1384" SPHEROID
["WGS_1984" 5375137.0,290 257229563 L FRIMEM -

0K | Cancel | INONE! WMNDNR

fppt.com



N5 lg9ulilsunsy DNR Garmin

v

* FNANTTUULNNA
_lf C:\Program Files(x86)\ArcGIS\Desktop10.0\

Coordinate Systems\Projected Coordinate Systems\
UTM\WGS 1984\Northern Hemisphere\

- @8N WGS 1984 UTM Zone 47N.prj
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¢ FNANTEZULNNA

H Open =
- -v-?l J <« UTM » WGE51984 » Morthern Hemisphere - | +4 | | Search Northern Hemisphere 2 |
Organize « Mew folder = ~ IZIEZI

' Favorites it Mame Date modified ik
[ ] VW3 LY54 U1V LONE 3HILPr| LfLA{£304 LG40
Bl Desktop

=

f12/2552 15:46
/1272552 15:46
12/2552 15:46
12/2552 15:46
12/2552 15:46

|| WGS 1984 UTM Zone 40N.prj
|| WGS 1984 UTM Zone 41N.prj
|| WGS 1984 UTM Zone 42N.prj
|| WGS 1984 UTM Zone 43N.prj
|| WGS 1984 UTM Zone 44N.prj

& Downloads

=1, Recent Places

= Libraries

m

. ~ Mo preview
|| WG51984 UTM Zone 45M.prj 12/2552 15:46 available

.H ’ - '
= Computer | | WG5S 1984 UTM Zone 46M.prj /1272552 15:46

f i r 0

i Local Disk (C) | | <G5 1984 UTM Zone d7N.pri > 12/2552 15:46

&a Local Disk (D) || WG51984 UTM Zone 48N.prj 12/255215:46  |E

s System Reserved || WG51984 UTM Zone 49N.prj 12/2552 15:46

s Local Disk (G:) || WGS 1984 UTM Zone 50N.prj 12/2552 15:46

= A Garmin GPSMAP WGS 1984 UTM Zone 51N.ori 12/255215:46 T
— = 1] I+
AN
/ File name: WGS51984 UTM Zone 47M.prj - IESRI Projection File (*.prj) v]

,L \\’k I Open |vl I Cancel I

e e e e el e e e e e

)

fppt.com
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¢ FNANTEZULNNA

- Tsunsuazuana A1 Projection Mvaanli

B MN DNR - Garmin o] @ [
File Edit GPS Waypoint Track Route Real Time Help

GPSMAP 62sc SEA 200

Lat Lon

Alt EPE »»» Data Table >
Connected @WGS_HELUTM_EDED

fppt.com
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e natdndiayaanLATasFLdyNn GPS

- 119 File --> Load From --> File

AN Browse U7 .. \Garmin\GPX\
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o dl o/ Qu/
. MstnTayaaInATassudtyunns GPS
A . B open
- 1aan File t}/F)EE &=l < Garmin » GPX »

1l GPS eXchange fwoan. = '

Format (*.gpx) -
dwrtonsll]
oo
A Garmin GPSMAP

File name:

~ | 44 || search Grx P |

Date modified

9/11/2556 12:438
3/4/2556 16:55
13/11/2556 2:42

Select a file to

preview.
¢
» | Text File (*.bat) -
ArcView Shapefile (".shp)
DBase IV (*.dbf)

Text File (")

oog gomoat (* km
GPS EXcha Format (*.gpx)
OWTaNce ERpo

SRLPie [ .bd)

~l

fppt.com
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e natdndiayaanLATasFLdyNn GPS

Ay Ny
- IRNUARDNANFARANINIT

al

ARN Open

B Open [
@Q?l | « Garmin » GPX » v [ #3 || Search Gex ol
Organize * New folder =+ [ @

4 Downloads o MName . Date modified

-| Recent Places .
) . Archive

., Curren

. Libraries

BirdsEye Demo.gpx
'8 Computer = Y 3

&, Local Disk (C)
= Local Disk (D)
ca System Reserved
ca Local Disk (G:)
A Garmin GPSMAP

| Garmin Waypoints.gpx
| Track_AREA.gpx

| Track_EX2.gpx

|| Waypoints_2013-11-13.gpx
|| Waypoints_2013-11-14.gp

G‘l_-l Metwaork

- 4 L1

File name: Waypoints_2013-11-14.gpx

9/11/2556 12:48
3/4/2556 16:55
13/11/2556 2:42
16/6/2553 2:05
9/3/2552 T:41
13/11/2556 21:33
14/11/2556 10:38
13/11/2556 21:30
14/11/2556 10:39

No preview
available.

k

- IGPS eXchange Format (*.gpx) v‘

| Open v | cCancel |

fppt.com
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e natdndiayaanLATasFLdyNn GPS

- Tisunsuazliiiaan Ussinn aasiaya

i Feature Type o |- B (|

Please Define the Feature Type

f+ W aypoint
(" Track
(" Houte OF.
DNRGarmin ==
= File was loaded successfully from JAGarmintGPXWaypoints_2013-11-14.gpx

oK

fppt.com
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e natdndiayaanLATasFLdyNn GPS

y

B MN DNR - Garmin o @ [

File Edit GPS Waypoint Track Route Real Time Help
GPSMAF B2:c SEA 200

Lat Lon
Alt EPE <4< Data Table <<
{* W aypoint " Track " Route " RTimewpt

o hpe ident lat long y_proj W_proj com
'IMﬁl“i Ex1-02 138371347636 1005721444264 1530271.96887458|  6E9914.934985122

B, 2 wAAYPOIMT | Ex1-01 138372988813 1006733388476 1530290 97321677 670043 995876348
—_— 3| wAAYPOIMT | Ex1-03 138373645554 1005715447012  1530296.96983789| BE9849.936254219

+ [ wAATPOIMT | Exd 13837154 1005737000  1530275.20138713)  670083.142723644

Bl wATPOIMT | Ex2 13837548 100572281 1530317 7824224 B69929.458838325

=
==
/IA f 4 N
Connected 0 af & Selected
7

fppt.com
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. nautlasdiayaanntrrasiudrynunns GPS iy Shape file
- 117 File --> Save To --> File

- Browse 1% Folder #629n1341 W8N Save as Type Ll

ArcView Shapefile (Projected) (*.shp)
- AAN Save
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. nautlasdiayaanntrrasiudrynunns GPS iy Shape file

H Save Az @
@le |« Work » ausuGPS_19112013 » Export ~ | 49 || Search Eport )
Organize » Mew folder 4= - II:ﬂ:ZI
& Downloads 0 Mame Date modified Type
= Recent Places
- || Track_2013 11 11.shp 12/11/2556 20:05 SHP File
e || Track_2013 11 13.shp 13/11/2556 21:37 SHP File
ibraries
o || Track_EX2.shp 14/11/2556 11:30 SHP File
N || Waypeint2013 11 09.shp 0:10 SHP File
| Computer
e 1 pl Disk (C3) = || Waypeint2013_11 11.shp 0:07 SHP File
e Local Disk (C:
— Local Disk (D) || Waypeint2013_11 13.shp 13/11/2556 3:04 SHP File
ocal Disk (D:
= g = || Waypeint2013_11 13 1.shp 13/11/2556 21:38 SHP File
stem Reserved
1= ) || Waypoint2013 11 14.shp 14/11/2556 11:29 SHP File
a Local Disk (G:)
A Garmin GPSMAI
- - 0 b
File name: -
=z~
AN
/ ATCTTETrSep
= %0 + Hide Folders DBase IV (*.dbf)
= VN Text File (Comma delimited) (*.txt)
N\ A Text File (Semicolon delimited) (*.bd)
= Google Earth Format (*.kml)

GPS eXchange Format (*.gpx)
Lowrance Export Text File (*.td)

fppt.com
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+ 11 Shape file NlFfauiLLL WHUNDNUsTINA
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» 1} Shape file NlFfauiuLL MMWaaaa5le4




mwgqmﬁmnmﬁ?ﬁﬂ AN N

1 dl v v o = = =] =
¢ ANANNGINIAAINNNITITRANINLN A ANINFIUNUAILNIST
(Ellipsoid) liausninun i lfae faednunisAtuanine

« a9 ki Model EGM96 (Earth Gravitational Model 1996) /
EGM2008




mwgqmﬁmnmﬁ?ﬁﬂ AN N

*  AINEY Orthometric = ANAINEAILNT - AN Geoid
(ANGIAINWURY Geoid DagLNedT)

GPS 4

5,
i

’"Ti H = - N
- / Oceans Orthometric Ellipsoidal Height  Geoid

Heign firom GPS Height

fppt.com



N5 lg9ulilsunsy DNR Garmin

AUNITUINLFAUD

NANIALLATWAIUUNALULAENITRITIARALNILN U

AUNNALULAENITRITAIALAZTINULHNUN
0-2579-2273




